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I. Introduction

This User Manual is designed to inform users about all steps necessary to install and run report-IT Client. It furthermore describes all functionality that is provided by this application, provides background information about certain technical topics and points out areas of difficult that can be encountered when using this application.

The following signs are used within this document:
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The question mark signals that additional information about a certain topic is provided in the box next to it. This information may concern technical matters or might just deal with questions that might occur when reading through the previous text.
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The exclamation mark signals a potential error source in the text next to it. A detailed information about this error source and how it can be avoided can be found in the box just next to the sign.
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This signals that the box next to it contains some information about a topic that was just discussed in the manual.

Words written in capital letter refer to directories on your machine. They are introduced at certain points in this manual.

Since this software is very complex, we recommend that you read this manual carefully before you install and run the software. 

II. System Requirements

This chapter informs you about the minimum Software and Hardware requirements that must be fulfilled by a machine in order to be able to install report-IT Client and run it properly.

1. Hardware

This software requires:

· Accessible CD-ROM or DVD drive

· 10MB of Harddisk space (this number may be higher depending on the number of users and reports)

· Configured Network/Internet access (depending on the intended usage of the software)

There are no further specific hardware requirements for this application. However we recommend the following minimum hardware configuration in order to ensure your software running smoothly:

· Pentium processor running at 200Mhz

· 128MB of RAM

· VGA graphic card and appropriate monitor

2. Software
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This is a 100% pure Java application and therefore Operating System independent. You can install it on a platform of your choice, as long as there is an appropriate Java Virtual Machine available for this platform. 

III. Installation

· Insert the installation CD into a CD-ROM or DVD drive that is accessible from the machine where you want to install report-IT Client. This drive will be referred to as YOUR_DRIVE.

· Execute the installation script that is suitable for your Operating System. The installation scripts are located in the rITClientInstall directory on your CD. For example:

· On Windows platforms: 
YOUR_DRIVE:\rITClientInstall\Setup.bat 

· On Unix/Linux platforms: 
YOUR_DRIVE/rITClientInstall/Setup.sh

· The application that guides you through the installation process starts and checks your machine for installed Java Virtual Machines (please refer to Chapter II for details about Virtual Machines).
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A Window pops up that contains a list of detected Virtual Machines that are suitable for this software. Select one of the entries and confirm your choice by pressing the OK Button.

· A welcome window containing information about the software you are going to install appears. Read the displayed information carefully. You can than continue the installation process by pressing the next Button.

· The next window prompts you to specify an installation directory for this application. You can either type in a directory, select a directory by pressing the Browse Button or use the default installation directory. The directory you choose will be referred to as INSTALL_DIR.

Pressing the Install button after you have made your choice triggers the installation of the application files on your machine. A progress bar informs you about the amount of work done and still to do.

· Another window informs you about the result of the process as soon as the installation is finished.

To exit the installation application, just press the Finished Button.

You are now ready to start your software.

IV. Start-Up and First Steps

This Chapter offers a Step-By-Step introduction of how to start the report-IT Client application as well as a description of some things that introduce you to the software and its purpose.

1. Starting the report-IT Client application

To start the report-IT Client application you need to execute the start script, named rITClient.bat or rITClient.sh, depending on your operating system. It is directly located in INSTALL_DIR.

After executing the script, a main application window appears in the middle of the screen. The whole application can be controlled with the facilities and functions offered from this window.

2. Login
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Although report-IT Client is now running, it is not yet connected to a Server. In order to work with this software, you need to connect your application to a corresponding Server application running on the same machine or on any machine you can reach via a network connection.
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To connect to a Server application, you just need to press the "Connect To Server" Button in the Tool Bar. It is the left-most Button. After doing so, a small window appears, prompting you to enter the IP address of the host machine, the Port number, under which the Server is running, your user name and the corresponding password. You will get all those information from your System administrator.
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When you are finished entering the required information, just press OK. The report-IT Client application now tries to connect to a Server application that is running on the specified machine and under the specified port.

3. Viewing the Welcome Report

After successful login, a corresponding message is displayed in the Status Bar at the bottom of the application window. The three lists on the left side of the window should now contain some entries in the form "userName\reportName.rit".

Now select the report named "Welcome.rit" from the list by clicking on it. The Server will be contacted and this report will be transferred to your application. Furthermore, any database that provides data for this report will be contacted as well and the required data will be sent to you. Your application assembles all the pieces of information.
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The main part of the main application window is made up of the space right from the three report lists. The two tabs at the top of this space allow you to switch between the report design view, allowing you to manipulate the general design of reports, and the report preview view, allowing you to take a look on report, displaying actual data. If it is not already selected, select the preview tab. You can now see the newly assembled Welcome report.

4. Disconnecting and Shut-Down

It is absolutely necessary for you to terminate your connection to the Server before quitting the application. This is because the Server application else would still think you are connected and would not allow you to connect to it again.

To terminate the connection, just press the "Disconnect From Server" Button which is located just right from the "Connect To Server" Button in the Tool Bar of the application window. A corresponding message in the Status Bar will inform you about success or failure of this operation.

After successful logout, you can quit the application by selecting the "Quit" option form the "File" menu or by pressing the small "X"-button in the upper right corner of the application window. 

V. The Main Application Window
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This chapter deals only with the main application window, that appears as soon as the application is started (as described in chapter III of this manual). It describes the overall layout of the window, which offers access to all functionality offered by this application.
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1. Menu Bar

The Menu Bar is located at the top of the window and contains only two major categories, "File" and "Help".

To end the application, select "Quit" from the "File" menu. To get information about this application, select "About" from the "Help" menu. A window will appear, displaying information about the software, its version and possibilities to get further information about this application.

2. Tool Bar

Just below the Menu Bar in the upper part of the application window, the Tool Bar consists of five Buttons. The functionality of those five Buttons is described in the following paragraphs, starting from the left-most button, and working on to the right.

· "Connect to Server": Clicking this button brings up the connection dialog, offering the possibility to enter the Server name, the port number, user name and password to connect to a running Server application (as described in chapter IV.2). 

This only happens as long as there is no active connection to a Server. If there is already a connection, a message is displayed in the Status Bar of the application window.

· "Disconnect from Server": Terminates the active connection to the Server application. This only works when there is an active connection. Otherwise a error message is displayed in the Status Bar of the application window.

· "Create new Report": Brings up the Create Report dialogs. A detailed description of the process of creating reports can be found in Chapter VI of this manual).

· "Save Report": Saves the current report under a specified name. A detailed description of the process of saving reports can be found in Chapter VI of this manual).

· "Refresh Report Preview": Pressing this button results in an update of the report preview. Changes made to the design of a report become part of the preview. Please refer to Chapter VI of this manual for details about designing Reports and the report Preview.

The Tool Bar is detachable. This means that it can be moved to any place on the screen regardless of the position of the Main Application Window. To do this, just keep the left mouse button pressed at an empty space in the Tool Bar and move the mouse to the intended position of the Tool Bar. Releasing the mouse button places the Tool Bar at the current position of the mouse pointer.

3. Working Area

The Working Area is situated just below the Tool Bar and makes up the biggest part of the Main Application Window.

It is divided into two sections, divided by a vertical bar. The two sections can be resized by clicking on the bar. Keeping the left mouse button pressed and moving the mouse results in a corresponding resize. Just release the mouse button to end the resizing process.

The left section contains three lists. These lists contain the reports that are accessible to the currently logged-in user. The first list contains the users own reports, the second contains reports of the group this user belongs to and the third contains all other accessible reports. Furthermore, there is a "Update" Button just at the bottom of the left section. Pressing this button results in an update of the lists.
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The right sections of the working area displays either the design view, to manipulate reports, or the preview view to view existing reports. The two tabs at the top of that part of the window allow toggling between the two views. Please refer to Chapter VI for details about designing reports and the report preview.

4. Status Bar

The Status Bar is a single line at the very bottom of the Main Application Window. It displays information about the Status of the application and possible error messages. It also displays information about the results of actions.

If there is more than one message, the Status Bar becomes scrollable. Using the two small arrows on the right side of the status bar allows scrolling through all messages that were displayed in the runtime of the application. Pressing the upper arrow scrolls to older messages, pressing the lower arrow scrolls to newer messages. As soon as a new message arrives, the Status Bar scrolls to display this message, regardless of what message was displayed last.

All messages are displayed in the form: "Date_Of_Occurrence: Message", where Date_Of_Occurrence specifies the exact time and date of when the event the message describes happened.

VI. Functionality Description

This chapter describes the four most important features of this software in detail, Creating new Reports, Manipulating Reports, Viewing Reports and Saving Reports. It is recommended to read this chapter only after reading the previous chapters of this manual, since the information provided in those chapters is required to fully understand the following sections. 

Each feature is dealt with in a separate section of this chapter.

1. Creating new Reports
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The only way to create a new report is by pressing the "Create new Report" Button in the Tool Bar, provided a connection to a running Server has previously been established. A series of three dialog windows guides through the whole process.

[image: image32.png]report-IT: Client [-[O[x]
File  Help

zl=]| ol =]

StandardUserwelcome it
B i} = B = | W Display Column Headers
Defautt =]

OrderhNa] Order... | Order... Produ... Produ.. | Produ,

Display _|rename |rename |rename |rename [rename [rename
Grouping__|ungro... [ungro... [ungro... [ungro... |ungro... |ungro,
Group Reports: Sorting_[unsort._[unsort.. [unsort. unsort.. [unsort . unsort

Visibilty _|visible |visible |visible |visible _|visible |visible
Formating _[none |none [none [none [none_|none
Aignment__[1en  [len  |len Jlet [lst e

Additional Reports:

: Connected to Server.




The first window offers the possibility to enter a name for the new report as well as to choose a data connection that will be used as source of data for this report. A list of connections that are available for the currently logged in user is displayed within a ComboBox in the upper right corner of this window.
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To change the report name, just select the field labelled "Report Name", and enter a name of your choice. This name should be a single word that should not contain any special characters (like "#", ".", and so on).
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Selection one of the Connections fills the left of the three lists in the lower part of this dialog with the tables that are available via this Connection. Selecting one of the tables fills the centre list with the fields contained in this table. The right list contains the fields that will be part of the report. The four Buttons can be used to add fields to and to remove fields from this list.
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Pressing the "Next" Button when the selection is complete closes the first dialog and displays the second. The second dialog can be used to restrict the data that will be used for this report with certain parameters. The left list displays all fields that have been selected in the previous dialog. The upper right part contains a new restriction, that is just being built and the lower right part contains already build connections. The two buttons between those two parts can be used to add the actual restriction to the restriction list or to remove the selected restriction from this list.

Building a new restriction is quite simple. The first step is to select a field from the list by clicking on the fieldname. It will be displayed in the left part of the building area, followed by selecting the kind of the restriction. The ComboBox just right of the fieldname contains a selection of possible restrictions. The last step is to specify the restriction range. 

After this three steps are completed, pressing the "Add Restriction" Button adds the newly created restriction to the restriction list just below the built area.

Removing a restriction from the list is just as easy as creating and adding a new one. It is achieved by selecting an entry from the list and pressing the "Remove Restriction" Button.
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When all wanted restrictions are created, pressing the "Next" Button opens the third and final dialog, allowing definition of data joins of fields.
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Again, the left list contains all the fields that have been selected in the first dialog. The right side of this dialog consists of a smaller upper part that can be used to assemble a new join, and a bigger lower part that holds a list of already existing joins. The two buttons between those areas can be used to add the actual join to the list or to remove the selected join from the list.
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Selecting a field from the left list displays the fieldname in the left part of the build area. Selecting another field from the list displays this name just right of the first one. The join is now complete. Pressing the "Add Join" Button adds this join to the list. If there was an error in the selection, selecting a third field from the list erases the previous selections.

To remove a join from the list, just select it and press the "Remove Join" Button. Pressing the "Finished" Button at the bottom of the last dialog when all joins are created indicates that the process of creating a new report is finished. The windows are closed and the data for this report is retrieved from the server, using the specified parameters.

2. Designing Reports

After report has been selected from one of the report lists on the left side of the main application window or after a new report has been created, its design and the presentation of its data can be changed.
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This can be done by using the interface provided in the "Design" tab on the right side of the main application window. 
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The design interface consists of a small Tool Bar and a main working area. The Tool Bar contains five buttons and three other objects, providing all necessary options to change the design of the report. Those functions are dealt with later within this section of the manual.

The main working area just contains a table. The columns of this table represent columns in the final report. When a new report has been created, the table is made up of a column for each selected data field. 

The grey row at the top of the table displays the name of the field. This name cannot be modified. The other rows can be used to change certain properties of each column or the representation of the data of each column.

· Display: The name entered here will be displayed as column name instead of the name of the field. This makes it possible to give meaningful names to columns, since field names in tables are not necessary chosen to be meaningful to users.

· Grouping: The fields of this row can have two values: "grouped" and "ungrouped". When set to grouped, the displayed data will be organised in groups of data-sets. The value of the grouped column is only displayed once in each group. It is also possible to define functions like sums on groups instead of on the whole report. A group change occurs when the value of the grouped column changes. When this happens, a blank line and possible group functions are displayed in the report.

· Sorting: Values of a column can be "unsorted", sorted "ascending" or sorted "descending". The data is displayed accordingly to this setting.

· Visibility: A column can be made invisible by setting this value to "invisible". This means that this column's data is not displayed in the report, allowing columns with values that are only used for calculations but will not be displayed.

· Formatting: Clicking on the cells of this row brings up the "report-IT Format Editor". This editor can be used to change the format of the displayed data, as well as to define functions in user added columns.

To define a function just select the type of the function from the provided ComboBox and enter the names of the columns this function will be applied to in the field below this ComboBox, separated by a colon. 

· Alignment. The final row allows changing the alignment of the displayed data. Possible values are "left", "right" and "centre".

The five button in the Tool Bar of the Design tab are offering the following functionality:

· Add column: This button adds a column to the table. Since this column does not contain values of a database field, its name is set to "UserAdded". Such columns can be used to display the results of special functions, like sums or products of other columns, as described earlier in this manual. All the design possibilities described for data columns can also be applied to user added columns.

· Remove column: Deletes the actual selected column from the table. This only works for user added columns. Data columns cannot be removed. To not display a data column, the "Visibility" attribute of the column should be set to "invisible" as already described in this manual.

· Add row: Adds a row to the table. The number of rows that can be added is not limited. Rows can be used for functions that can be applied on groups or globally. Those functions currently only engulf displaying text and sums. Clicking on a cell in an added row displays the "report-IT Function Editor". The dialog allows selecting a scope for the function (either group or global) to select a function type and to enter the function details. Sums do not require any details. The details for a text function would be the text to be displayed. In each row a function can be assigned to every column. 

· Headers and Footers: Pressing this button brings up a dialog that allows selection of headers and footers for this report. A report can be assigned two headers and two footers (one header/footer for the whole report and one for each page). The ComboBoxes contain the available files for each category. Pressing OK assigns the selected headers/footers to this report.

The other components of the Tool Bar provide the following design functionality to the user:

· Display Column Header: The names, stated in the display row of each column, are displayed in the report only when this option is selected. Otherwise, no column caption at all is displayed.

· Font Type: This changes the font that is used to display the report data.

· Font Size: This changes the size of the font.

It is also possible to change the order of columns by clicking at the first row (the grey row displaying the field name) and dragging it to its intended position in the table with the mouse button still pressed. Releasing the mouse button moves the column to the new position.

Furthermore it is possible to change the width of a column by clicking on the dividing line between two columns and dragging the mouse. 


3. Viewing Reports

Clicking on the "Preview" Tab displays the actual report. Unlike the "Design" Tab, the "Preview" Tab is activated for all reports that are accessible for the current user. The Preview displays the current report with all its design settings, including headers and footers in an uneditable HTML panel.


4. Saving Reports

In order to make changes to reports or new reports persistant, it is necessary to save them. All reports are centrally saved on the server and are therefore accessible from everywhere, independent of the machine the user is working on. 

To save a report, just press the "Save" Button in the Tool Bar of the main application window. A dialog pops up, allowing you to specify the name under which the report is to be saved. 

The name is preceded by the name of the current user. This name must always to be provided, since the reports are organised in folders corresponding to user names.

Appendix A: Feature Table

The following table gives an overview about the features included in this version of the report-IT Client application.

The grey column indicates the actual Version. Features are grouped into certain categories.

(
indicates that this feature has been realised in this version

(
indicates that this feature is planned to be realised in the corresponding version

(
indicates that this feature is realised in this version but has been realised in an   earlier version 

Feature
Version 1.0
Version 2.0
Future Rel.

Security:




- Encrypted configuration files
(



- Secure Client/Server Communication

(


- Guard Object for access control

(


- Authenticity codes

(







General Features:




- Platform independent
(



- Dynamical report creation
(



- Printing reports

(







Report Design:




- Adding and removing additional Columns
(



- Adding and removing function rows
(



- Supporting single group/global functions
(



- Supporting multiple group/global functions

(


- Changing table appearance
(



- Resize table columns
(



- Column display names
(



- Data grouping
(



- Data sorting
(



- Setting columns invisible
(



- Formatting data columns

(


- Formatting user added columns
(



- Changing alignment
(



- Supporting row functions
(



- Moving Columns within the table
(








Report Presentation:




- Report presentation in HTML 3.2
(



- Report presentation in HTML 4

(
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The platform-independence of Java is mainly achieved by the fact that Java accesses the underlying hardware via a piece of Software, called Virtual Machine, instead of accessing it directly in the way of 'traditional' programming languages. The Virtual Machine copes with the specific features of each Operating System, and offers an interface for Java applications, which allows them to remain unchanged regardless of the Operating System they are running on. 


As long as there is an appropriate Virtual Machine, a Java application can run, because it finds the required interface.


If you are not sure, whether or not an appropriate Java Virtual Machine is installed on your Machine, just start the installation program as described in Chapter III of this manual. The installation program checks your machine for available and suitable Virtual Machines.
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If there are more than one Virtual Machine listed, you can choose any one, without affecting the software or its performance. All listed Virtual Machines are equally suited to support this application.


If there is no Virtual Machine listed, you can easily download one as well as installation instructions from � HYPERLINK http://www.javasoft.com ��www.javasoft.com�. This Download is free of charge.
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It is absolutely necessary to connect your Client application to a Server. The Client application only offers you a gateway to the information and functionality provided by the Server.


Out of security reasons, there is no possibility to access data without using the Server. 


Furthermore, all reports created by you and other users are centrally stored by the Server and can only be access via the Server.





Please note that the whole application reacts case-sensitive. This means that it differs between lower-case and upper-case letters. Therefore if the correct password is "MYPassword", entering "myPassword" as password would not grant you access, since it would not being considered as a valid.
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Don not worry if there is no "Welcome.rit" report or no report displayed in the three report-lists after login. This might be because your current login gives you no access to any existing reports.


Just take a look at the general layout of the application and continue to next section of this chapter.





�


�





�





Figure 1: The Main Application Window
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The three report lists can be empty when there are no accessible reports available to this user. There are never any reports displayed, as long as there is no connection to a running Server application.


To keep the network traffic as small as possible, there are no regular updates of the report lists. Any update must be initialised manually. This is even necessary to display a newly created report.
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Even if a report is accessible, this only means that the user can preview it. He might not necessarily have the right to change the design of this report. 


It is therefore possible, that the "Design" tab is deactivated for certain or all reports the currently logged-in user can access.
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Some of the things that can be done when creating a report cannot be undone or changed later.


It is therefore necessary to consider the intended result carefully before starting to create a new report.
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Figure 2: Creating Reports (1)
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The right list contains the fields that will be part of the report that is to be created. Fields from different tables can be part of the report. However only tables that are available via one connection can be used in one report. 


The selected fields are displayed in the form "Tablename.Fieldname".
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Figure 3: Creating Reports (2)
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A join is a database operation that relates two or more tables by means of values that they share in common.


This means supposed you use values from two or more different tables that are correlated by a field, for example the customer ID, you can define a join on the customer ID in each of the tables. The result is a set of data, containing fields from all tables but oriented around the customer ID field. 
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Figure 4: Creating Reports (3)





Please note that joins that specify fields of the same table as well as joins that specify the same field twice are useless and are therefore not created.
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Please note that depending on the access rights of the currently logged in user to the selected report, the design tab is not necessarily activated. 


It is therefore not always possible to change the design of reports.





Figure 5: The Report Design Interface
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In most cases, grouping the data of a column is only useful when the data is also sorted, either ascending or descending. This is because the value of unsorted data of a column may change with every data set, triggering a group change each time.
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In the current version 1.0 of this software, changing the format of the displayed data is not supported. However, it is possible to define functions in user added columns. How to add such a column to the report is explained later in this section.





Figure 6: report-IT Function Editor
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The "Edit" buttons in this dialog are currently disabled, since this version 1.0 of this software does not support editing those files.


Please contact your administrator in order to introduce new files or to change existing files.
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All reports are presented as HTML. This version 1.0 of this software only supports HTML in its version 3.2. This HTML version does not support changing the font of tables and the width of table columns. Therefore, changes in these options do have no effect on the preview of a report.
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Please note that some changes in the design do not automatically take place. In those cases it is necessary to press the "update" button in the Tool Bar of the main application window in order to make the "Preview" display the report with its actual settings.
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Figure 7: Report Preview Tab
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Table 1: Feature Table of Version 1.0








